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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Attention Indicates procedures which may result in damage or injury if sufficient care is not taken.
== Indicates additional information and points which may be useful to know regarding a topic.
/@\

- Indicates a page where detailed information regarding a topic can be found.

Procedure Indicates operating methods and the order of operations.

The procedure indicated should be carried out in the order of the numbered steps.

[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.

Example: [Esc] button

"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.
Timer (Boldface) Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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EasyMP Monitor Features



Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the statuses e Mail notification function settings
of multiple EPSON projectors that are connected to a network at a You can set e-mail addresses to which notifications are sent if a status
computer monitor, and controlling the projectors from the computer. requiring attention, such as a problem, occurs with a projector that has

Following are brief descriptions of the monitoring and control functions been registered.

that can be carried out using EasyMP Monitor.

¢ Registering projectors for monitoring and control
Projectors on the network can be searched for automatically, and you can
then select projectors to be registered from the projectors that are
detected.
You can enter the IP addresses for target projectors to register them.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

/O000DRRY

e Monitoring the statuses of registered projectors
The power status (ON/OFF) for projectors and problems or warnings >
requiring attention can be checked visually by means of icons. 4 \ D
You can select groups of projectors or a single projector that you are [ @g
interested in, and then check the cumulative lamp operating time or the - .
details of information such as input sources, problems, and warnings for

these projectors. -»~-  To enable projectors to be monitored and controlled even when they

@ are in standby mode®, make the following settings at the projectors.
The settings that need to be made will vary depending on the
projector you are using. @ Projector's User's Guide

¢ Controlling registered projectors
Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.
Web control functions can be used to change the settings in the * Set Network Monitoring to On.
projector's configuration menu. * When the projector's (}) indicator is lit orange.
If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use Timer Settings to
register timer settings.

e Set Standby Mode to Communication On (or Network On).




Installing EasyMP Monitor

Operating environment Supported language
This software is compatible with computers that comply with the following EasyMP Monitor supports the following languages.
requirements. - . . . B R
BAZE, English, Frangais, Deutsch, Italiano, Esparol, Catala,
oS Windows 98 Second Edition SP1 Portugués, st=01, XX (&), H X (8&4K), Nederlands, Dansk, Polski,
Windows Me Magyar, Cesky, Romana, Slovenscina, Norsk, Svenska, Suomi,
Windows NT4.0 SP6 Pycckuit, YkpaiHceka™*1, EAAnvika, Tirkge, duy=l1*2 | amwlne,
Windows 2000 Professional SP4 Bahasa Indonesia, Hrvatski, Slovencina, Bbnrapcku esuk, s« e,
. K . A . *2
The following 32-bit operating systems: tieng Viet, nmay
Windows XP Home Edition SP2/SP3 *1 If your OS is Windows Vista, you must update to Windows Vista SP1 to use
Windows XP Professional SP2/SP3 the Ukrainian version of EasyMP Monitor.
Windows Vista *2 Windows NT4.0 does not support Arabic and Hebrew versions.
(All editions except Starter Edition)
Windows Vista SP1/SP2
(All editions except Starter Edition) Tra nSferring the settings
Windows 7
(All editions except Starter Edition) If you are already using EasyMP or EMP Monitor, you can transfer the
e Internet Explorer Ver. 5.0 or later must be installed. projector settings to this version. The settings are stored as a data file (EMP
CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz or Monitor.dat). Make a copy of the EMP Monitor.dat before you install this
higher recommended) software. EMP Monitor.dat can be found at the following location if the

default settings were used to install the software:
Memory capacity | 64 MB or more (128 MB or more recommended) &

Free hard disk 50 MB or more o If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP

"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx
(Ver. x.xx represents the software version)"

space

Display SV]GA (800x 600) or higher resolution, 32 bit or higher display
colour

e If your operating system is Windows Vista or Windows 7

"C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx represents the
software version)"
If you cannot find the "AppData" folder, click "Start" - "Control Panel" -
"Appearance and Personalization" - "Folder Options". Select "View" tab,
and then configure the "Show hidden files, folders, and drives" setting in
"Advanced settings".

e Macintosh computers cannot be used.

e Operations carried out at the computer may become slow depending on
the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.



Installing EasyMP Monitor

After installing this software, follow the instructions below before starting
EasyMP Monitor to transfer the settings.

e If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP
Overwrite the existing EMP Monitor.dat file with the copy you made. The
existing EMP Monitor.dat file is in "C:\Program Files\EPSON Projector
\EasyMP Monitor Ver.4.40".

e If your operating system is Windows Vista or Windows 7
Place the copy of the EMP Monitor.dat file in "C:\Users\(User Name)
\AppData\Local\VirtualStore\Program Files\EPSON Projector\EasyMP
Monitor Ver.4.40".

’@_ The software name has been changed.
! Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace with this
software.

e When using Windows Vista: You must update to Windows Vista SP1
to use the Ukrainian version.

When the language selected for the EasyMP Monitor installation varies
from that of the OS being used, the screens may not be displayed correctly.

Procedure

/ Turn the computer on.

To prevent problems from occurring during the installation, we
recommend that you terminate all resident applications that can be
ended.

, Load the supplied Projector Software CD-ROM in your
computer.

The installer automatically starts up.

From here, continue with the installation by following the on-
screen messages.

Installing

Limitations imposed by a Windows Vista or
Windows 7 environment

When you are using the following OS, you must have administrator
authority in order to install EasyMP Monitor.

e Windows 2000
e Windows Vista

e Windows NT4.0
e Windows 7

* Windows XP When using EasyMP Monitor under Windows Vista or Windows 7, note

the following limitations.

® You must have administrator authority in order to use Register at
startup on the Environment setup screen of EasyMP Monitor.
@ "Monitoring using the system tray" p.25

e If EasyMP Monitor is installed on your computer, uninstall it before
you update the operating system to Windows Vista or Windows 7.
Updating your OS without uninstalling the software may cause a
malfunction. @ "Uninstalling EasyMP Monitor" p.41

If EasyMP or EMP Monitor is already installed, uninstall it before installing
this software. @ "Uninstalling EasyMP Monitor" p.41

When your OS language is supported by EasyMP Monitor, the software is
installed in the same language as your OS automatically.

However, the following cases are exceptions.

e When using Windows NT4.0: Since Arabic and Heblew are not
supported, English is selected for the installation.



Installing EasyMP Monitor

Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
monitoring and control.

e The computer and the projectors must be connected to the network.

e If using Windows 2000/Windows NT4.0/Windows XP/Windows
Vista/Windows 7, the computer must be started up in Administrator
mode.

e Depending on the projector model, a commercially-available serial «»
TCP/IP conversion adapter and a connection cable are required in order
to use EasyMP Monitor. @ Projector's User's Guide "Standby Mode"
Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.



TOP

Using EasyMP Monitor



Registering and deleting projectors for monitoring

This operation is carried out when starting EasyMP Monitor for the first
time after it has been installed and when you would like to add projectors.
Once a projector has been registered, the status for the projector will be
displayed automatically each time EasyMP Monitor is started from that
point onwards.

The operations to register projectors vary as followings depending on where
the projectors are connected to in the network.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering
projectors using automatic search (Searching for and registering
projectors that are located in the same segment)" p.11

e When registering projectors that are in multiple segments of the
network. @ "Setting the range of addresses to do an automatic search
and registration" p.14

Starting EasyMP Monitor

/ Click "start" - "Programs” (or "All Programs") - "EPSON
Projector" - "EasyMP Monitor Ver.4.40" in that order to start
EasyMP Monitor.

/ The main window will be displayed.

The red box area described in the screen below is referred to as
Grouping view.

- OX

View Tool  Help

Sekectal B SS-RER 33 =m =L

Registering projectors using automatic search
(Searching for and registering projectors that are
located in the same segment)

Procedures for automatic search

Procedure

\_J Right-click in Grouping view and select "New" -
(automatic search)".

"Projector

The following Create new projector (automatic registration) window
will be displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.



Registering and deleting projectors for monitoring

Al/s

== * You can also carry out this operation by selecting New - Projector
'@‘ (automatic search) from the Edit menu.

e Projectors that are using a serial «» TCP/IP conversion adapter
cannot be detected.

Procedures for registration

Procedure

[ Specify an address range and search, gw\"” %é
Stertaddess | | Endeddhess | \_/ Select the projector(s) to be registered from the displayed list,
Search Edit Cancel and then CliCk "Edit"-

The following window will be displayed.

%@s? Click "Search".

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". @ p.16

Create new projechor (automatic registration;)

Projector name IP address
Projector10 192168040
Projectord 192168041
Projector12 192168042
Projector!3 192168043
Projector1d 192168044
Projector1s 192168045
Projector16 192168046

[ Specify an address range and search.

Start address End address

Search Edit Cancel




Display name

Display jcon

Parent group

Projectar name

IP addresz

-
Port Mumber
Monitor Pazsword

Description

v M oritar

Registering and deleting projectors for monitoring

1 | ﬂ
| Mone) |
|Projectorin
| 160 . 254 183 . 10 Search

L

HReaqister Caticel

Make the necessary settings while referring to the following table.

Projector name

This shows the name that has been registered on the
projector.

IP address

This shows the IP address for the registered projector.

Use Serial &
TCP/IP conver-
sion adaptor.

This cannot be selected when registering projectors
using automatic search.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered.

Description You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

Display name

Enter the name of the projector(s) to be displayed in

g“‘%g
@ After entering the details, click "Register" to start the

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat Steps 1 and 2.

Grouping view or Detail list view. ~@—_ Projectors that have been registered using automatic search are
’

Up to a maximum of 32 bytes can be entered. A space g searched for again by projector name each time EasyMP Monitor is

cannot be used as the first character. started.

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Display icon

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be selected.
@ "Registering several projectors to a monitoring

group all at once" p.17




Registering and deleting projectors for monitoring

5

4

a%@ To end the registration operation, click E in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.20 for details on using
the Grouping view and Detail list view.

Setting the range of addresses to do an automatic

h . ° @peufy an address range and search.
searc and regIStratlon Stark address ( 192 , 168 . 0 . 00 )gdaddress ( 192 , 168 . 0 . 50 "
>
Search Edit Cancel

:@: Projectors that are using a serial «» TCP/IP conversion adapter cannot
> ~

4

be detected.

" Click "Search".

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

Procedures for automatic search

Create new o {automatic registration)

Projectar name IP address
Proce ure Frojector10 192168040
. Projectori 192168041
\- . . . . . " " " . Projectar12 192168.042
J Right-click in Grouping view and select "New" - "Projector Frojactor!3 192168043
(automatic search)“. Projector14 192.168.0.44
Frojector1s 192168045
The Create new projector (automatic registration) window will be Projestor6 192163046

displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

|v Specify an address range and search.

Start address 192 . 168 . 0 . 00 End address 192 . 168 . 0O . 50

Select the "Specify an address range and search." check box :
and then enter "Start address" and "End address" in the range. Reatch

Edit Cancel




Registering and deleting projectors for monitoring

Procedures for registration

Procedure

/ Select the projector(s) to be registerd from the displayed list,

and then click "Edit".
The following window will be displayed.

Create new projector {aubomatic search)

Dizplay name

Dizplay icon

Parent group

Prajectar harme

IP address

n
Part Humber
Monitor Password

Description

[ M onitar

|[None] j

| Projector10

| 169 . 254 . 183 . 1A Search

—
|

Register Cancel

Make the necessary settings while referring to the following table.

Display icon Select the icon(s) to be displayed in Grouping view or
Detail list view.
Parent group Select when registering a projector in a group.

If no groups have been created, this cannot be selected.
@ "Registering several projectors to a monitoring
group all at once" p.17

Projector name

This shows the name that has been registered on the
projector.

IP address This shows the IP address for the registered projector.
Use Serial «» This cannot be selected when registering projectors
TCP/IP conver- | using automatic search.

sion adaptor.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered.

Description You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

/ After entering the details, click "Register" to start the

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat Steps 1 and 2.




Registering and deleting projectors for monitoring

) To end the registration operation, click E in the top-right

corner of the window or click "Cancel". Display name I
éhe ic.on(s). of the lg)rojic‘igr(s).you registered will be displayed in b
rouping view or Detail list view. | < —
Refer to @ "Monitoring window layout" p.20 for details on using e @ '
the Grouping view and Detail list view. « | ]
Barent group | [Mane] ﬂ
Registration by specifying an IP address (Manual Proector pame |
registration) IP address | : : : Search

[ Usze Serial <+ TCPAP coreersion adaptar.

Procedure Fart Mumber
I

Monitor Passwond

®§ Right-click in Grouping view and select "New" - "Projector
(manual registration)". Digseription

The following window will be displayed.

If Detail list view is displayed, select New - Projector (manual =l

registration) from the Edit menu. Register Cancel

- You can also carry out this operation by selecting New - Projector
(manual registration) from the Edit menu.

Enter the IP address of the projector to be registered in the "IP
address" box and then click "Search". When the message is
displayed, click "OK".

If using a serial «» TCP/IP conversion adapter and cable to connect
the projector, select Use Serial «» TCP/IP conversion adaptor., enter
the port number in Port Number, and then click Search.
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After searching is complete, enter the information for the

projector to be registered while referring to the table below.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view. Up to a maximum of 32
bytes can be entered. A space cannot be used as the first
character.

After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Display icon

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Parent group

Select when registering a projector in a group. If no
groups have been created, this cannot be selected.

@ "Registering several projectors to a monitoring group
all at once" p.17

Projector name

This shows the name that has been registered on the
projector.

sion adaptor.

IP address This shows the IP address that you entered in step 2.
Use Serial «» Select this if using a serial «» TCP/IP conversion adapter
TCP/IP conver- | to connect the projector.

Port Number

If using a serial «» TCP/IP conversion adapter to connect
the projector, enter the port number.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered. If using a serial «» TCP/IP
conversion adapter to connect the projector, the Monitor
Password security function cannot be used.

Description You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

Registering several projectors to a monitoring
group all at once

Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent group,
monitoring and control operations can be carried out for all projectors in
that Parent group.

A Parent group can be set for other parent groups, so that a hierarchical
group arrangement can be created.

First, create the registration groups, and then register projectors into the
groups that have been created.

Procedure

’ Right-click in Grouping view and select "New" - "Group".

The following window will be displayed.
Make the necessary settings while referring to the table below.

If Detail list view is displayed, select New - Group from the Edit
menu.
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Group name | |
Dizplay ican
. i
Barent group |[Nune] j
=
Register Cancel

Group name Enter the name of the group to be displayed in Grouping

view or Detail list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping view or

Detail list view.

Parent group This selects the parent group. If no groups have been

created, this cannot be selected.

Monitor Select this to monitor all projectors that have been
registered in the group. If this is not selected, the settings
made when the individual projectors were registered will

be used.

It cannot be set when creating a new group.

' When the setup is complete, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

\Z/ Right-click the projector icon(s) to register to the group you
have created in Grouping view or Detail list view, and select
"Edit".

N4

:@—_ You can also carry out this operation by selecting Edit in the Edit
v menu.

4

’ In the Edit projector window, select the group name to use for
registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in
Grouping view or Detail list view.

Al
~ =

~r~- The registration details can also be checked using Projector list in the
’@ View menu.

\ls
~ =

~r- You can also carry out this operation by selecting New - Group from
'@‘ the Edit menu.

If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

Right-click on a projector icon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".
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:@—_ You can also carry out these operations by using the Edit menu.
» N

/ If only the projector name has been changed, click "Search" in
" the Edit projector window that is displayed. If the IP address
has been changed, enter the new IP address in the "IP address”
box and then click "Search”". When the message is displayed,
click "OK".

’/ When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic search

Procedure

Delete the projector(s) whose name or IP address has been
changed in Grouping view or Detail list view. @ p.19

Carry out automatic search to re-register the projector(s).
@ p.11

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer required
for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted in
Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follow.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

:@—_ You can also carry out this operation by selecting Delete in the Edit
N menu.




Monitoring window layout

Types of monitoring windows and switching How to switch views

method Grouping view and Detail list view are switched as follows.

Types of monitoring windows

There are two types of monitoring windows. Select a desired window. Click the View menu, and select "Grouping view" or "Detail list

¢ Grouping view view".
This view lets you check the status of group registrations in a
hierarchical diagram.

Bt wew oo Heb L] L] L] L] [ ]
e PP EE—— Monitoring using Grouping view
C) @ . . . .
8 0 e Meanings of Grouping view icons
e m@ In Grouping view, the patterns on the icons indicate the statuses of the
wwwwwww projectors. If the group icons are round in shape, it indicates that there is
W e ! another level below them. @ p.21

Grouping view

Fle Edt Wew Tool Help
e Detail list view i il OO =&~ =B @ EY
This view lets you display the status of each projector as a list so that s
the projectors can be checked in detail. You can also display specific
items as a list, and sort display items using a specific row as a sort

Branch B BranchC

c
c

Corwentian
== Showoom e Labby

= A

Showroom A Showmom B

,,,,,

CPOEHEPDEEEBED T R
000000000 0®000

RRRRR

T o
Detail list view @




Monitoring window layout

The icon patterns and their meanings are explained below.

Group

No warnings or problems
All projectors in the group are normal.

Warning or problem
A projector in the group has a warning or problem status.

Notification
A projector requiring immediate attention has been detected within the
group.

Monitoring disabled

The projector is not being monitored. If you right-click the icon and select
Monitoring enabled, the projector will be added to the projectors that are
being monitored.

S

Data being updated

Projector

wa

No warnings or problems”!

Warning or problem

Notification

Monitoring disabled

Data being updated

84« @ 0 &

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was registered,
or an incorrect Monitor Password was entered. @ p.12, p.15, p.16

Projector

Network error (TCP connection error)*2
=X

Eﬁ' Network error (ESC/VP.net communication error)*3
(?

=y

*1 When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off. As
you can get an idea of how the temperature inside the projector is increasing
when Temperature level is displayed, you can make improvements to the
projector's operating environment before a high internal temperature error or
high-temperature warning occur. @~ p.25

*2  Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.

*¥3  Check that the projector has been correctly connected to the network.

- The projector information that is generated when a problem is

@ detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click "Refresh" in the main window to update the
status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.
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e Expanding and collapsing icons e Warning or problem
Each time you double-click a group icon, the icons for the projector An error has occurred on the projector.
that have been registered in that group are displayed or hidden. Notification

e Moving icons
To change the position of an icon within Grouping view, simply drag
and drop the icon to be moved.

The projector requires immediate attention.
. Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

Monitoring using Detail list view Data being updated

&
@ Network error (Monitor Password authentication error)
>

Meanings of Detail list view icons No Monitor Password was entered when the projector was

registered, or an incorrect Monitor Password was entered. @ p.12,
p-15, p.16

0l Network error (TCP connection error)*2

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.

G Network error (ESC/VP.net communication error)*3

L ?
I I S S D B O <
Group name
—m (2] p
|z = Zo E R When projectors are registered to a group, the name of the group that the
(3] obby @ H | | . . A
@ [Branch A/Convention Hall rojector]] @ 120H | — PrO]eCtor belongs tO 18 dlsplayed'
@) | fBranch arconvention Hal oisctorl2 (@) 60H | | 9 Display name
{2y | Jeranch a/showoom/showoom & | fiat @ 154 [ =]
& | ferancharshamaonsshomeoma | o2 (@) o (] ShOWS the dlsplay name.
gy | Jeranch A/shawoom/shawoom & | o3 @ a5 ]
@ Branch A/Showroom, /Shownoom B lod @ 20H | E——) P()Wer
@) | frsnch asshonoom, /Shomoom B | s @) 6aH | | ShOWS the pOWer on status fOr the projector'
(@) | JErenchB/Conterence Room i} @ 49H | |
Y | SR | o Toom e — @ Power on and normal status @ Power off and normal status
@ Branch B/Conference Room 0z @ 3BH | —
€@ | [prmetprmanierncenoon | oo Q@ i === @ Power on and abnormal Power off and abnormal
(@) | JeranchB/Reseption Fioom om 1 (@) 9 | = I status status
(@) | JBranch B/Reception Room o 2 @ B0H | | |
| I o] @ Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

@ Type () Temperature level

Displays the projector status. The following five icons display the differing internal temperature status of
ga No warnings or problems*! the projector.

The icon patterns and their meanings are explained below.
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mm | Internal temperature

= Internal temperature Supply System Error (Ballast) Supply System Error (Ballast
1)

normal normal
=== ] High-temperature == | High-temperature ¥4 Supply System Error (Ballast [g)] Auto Iris Error
warning warning 2)

Internal temperature
error

=i Cinema filter error i Shutter error
=

Cooling system error (Peltier Cooling system error (pump)

@ Error information
element)

Shows a notification or warning/problem status using the following icons.
— - . « rF Other error
Clean Air Filter Notice a Replace Lamp™4

*¥1 When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off.

*2  Check the following items.

8] Replace Lamp (Lamp 1) Replace Lamp (Lamp 2)

a] Lamp error (Lamp 1) Lamp error (Lamp 2)

1

Ulll

Lamp failure at power on
(Lamp 1)

High-temperature warning
| No Air Filter

Air Flow Sensor Err.

Supply System Error (Ballast
2)
Shutter warning

Lamp Error

Lamp failure at power on
(Lamp 2)
Replace Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning

Lamp Cover Open

Lamp Error (Lamp 1)

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
Check that the projector has been correctly connected to the network.

You can display Replace Lamp at any time preset at Environment setup in the
Tool menu.

@—_ e The projector information that is generated when a problem is
» ~

detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector
status returns to normal. Click "Refresh” in the main window to
update the status.

HE 9P PEE 9%

o Detectable error information differs with the projector you are

Lamp failure at power on using

Lamp Error (Lamp 2)

=)
3

Lamp failure at power on Lamp failure at power on
(Lamp 1) = (Lamp 2)
Low air flow error

3

High internal temperature Selecting display items

error
You can select only the required items to be displayed in Detail list

view.

Air filter air flow sensor error Internal Error

20 @

Fan error Sensor error

el
by
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Procedure Procedure

Select "Option" from the View menu. Click the item name of the row you want to use as the sort key.

@5

The Option window will be displayed.

Cpkian

Searching for desired icons (Projector list)

Dizplay ikemz

~ Tvpe The Projector list feature is useful for searching in lists when many groups
W Group name and projectors are registered and the icon you are looking for is not

I Fiojector name displayed on screen.

v Display name

I IP address Procedure

v Powuer

[ | L. H . . .
v Lo es Select "Projector list" from the View menu.

[ Source

The following window will be displayed.

v Temperature level

[ Description
[ Errar infarmation
Lobby
0k Cancel - Showroam
= Showroam A
) Mol
Select the check box of the item you want to display. E :Es
' + @ Showroom B
/] . " n + {3 Branch B
Click "OK". Branch C
 When all of the details of the item cannot be displayed in
" Detail list view, drag the boundary line on the right of the item With Projector list, temperature level icons are not displayed regardless of
name so that the view is extended to the desired width. the setting of Temperature level display group view at Environment
setup.

The Projector list lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, Grouping view and Detail
list view are scrolled so that the selected icon is displayed in the window.

Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as
projector name order or IP address order.
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Monitoring using the system tray E-

Temperature level display aroup view & 0 © in

The projector statuses are always displayed as icons in the system tray, even
when Grouping view or Detail list view is not always displayed, and the
statuses can be checked by the icon patterns.

Lamp schedule natification * Off  On 1000 3: Haur

Log output = 0f © On

™ Register at startup
When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

I~ Changs the application lack password

Old password |

Hew password I

New passward [confim) ]

oK Cancel

’ e Right-click the icon in the system tray to open a pop-up menu to

The icon patterns are explained below. '@‘ select the Open the main screen or Exit.

o If Register at startup in the Environment setup is selected, EasyMP
Monitor starts automatically when the computer's power is turned
on. When using EasyMP Monitor under Windows Vista or
Windows 7, you must have administrator authority in order to use

Procedure this function.

/ Select "Environment setup” from the Tool menu.

@ No problem /b, Problem

The Environment setup window will be displayed.

Displaying projectors with problem or warning
/ Select "Resident in the task tray". statuses in a list

You can display a list of only the projectors which have a problem or
warning status.

Procedure

Select "Warning and Error Projector list" from the View menu.
The following Warning and Error Projector list window will be displayed.
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If you move the mouse pointer over the icon of the Error information, @ Network error (TCP connection error)*2
details of the error and the remedy will be displayed. If you double-click in - o §
a line, the properties for that projector will be displayed. @ p.28 g Network error (ESC/VP.net communication error)™

@ Display name
Shows the display name.

© Fover
Refresh S lect al (D 0 &gm [% q%—ﬁﬁ(w

Type | Display namd § Powerl lLamp Hours Source | | Temperature level

Shows the power on status for the projector.

Enar information

Froectaot | | @) 120H I @ Power on and normal status @ Power off and normal status
Ho3 85H )
@ @ Power on and abnormal Power off and abnormal
status status

@) Lamp Hours

Shows the lamp operating time for the projector.

Source

< | o]

Shows the input source that has been selected for the projector.

A g Computer or Computerl B g Computer2
QoL=1 0oLz

@ Type Vi
WololoTe BNC 5 S-Video

Shows the group or projector status.

The icon patterns and their meanings are explained below.

ga No warnings or problems®! Video (RCA) Video (BNC)
H-r-- r|5i

Warning or problem

DVI-D1 or HDMII, DVI-D2 or HDMI2*5

DVI-D, HDMI*4

D-Video EasyMP
Giane

USB Display USB or USB1
e 1|

An error has occurred on the projector.

Notification

€ &

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

Data being updated

Network error (Monitor Password authentication error)

B 4

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered. @ p.12, @ Temperature level
p-15, p.16
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= | Internal temperature
normal

] High-temperature
warning

Internal temperature
error

@ Error information

Replace Lamp®6
Replace Lamp (Lamp 2)

Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)
Replace Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning

Lamp Cover Open

Lamp Error (Lamp 1)

HEY FEHE S ¥<9a

3| Lamp failure at power on

[
a3

Lamp failure at power on
~~ (Lamp 2)

‘ﬁ Low air flow error

Internal Error

The following five icons display the differing internal temperature status of
the projector.

== Internal temperature
normal

mmmm | High-temperature
warning

Shows a warning/problem status using the following icons.

8] Replace Lamp (Lamp 1)
Lamp error (Lamp 1)

a Lamp failure at power on
(Lamp 1)

[ High-temperature warning

= No Air Filter

Air Flow Sensor Err.

Supply System Error (Ballast
2)
Shutter warning

Lamp Error
Lamp Error (Lamp 2)

Lamp failure at power on
(Lamp 1)

High internal temperature
error

W EEMER © N

Fan error

L
vy

*1

*2

*3
*4

*5

*6

@ Sensor error Supply System Error (Ballast)
[ Supply System Error (Ballast [l Supply System Error (Ballast
. ;

Auto Iris Error Cinema filter error

.[:1 Shutter error .[1 Cooling system error (Peltier
SH FE
element)

Cooling system error (pump) Other error

When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off.
Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
Check that the projector has been correctly connected to the network.

It describes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.

It describes HDMI if the projector is equipped with both DVI-D and HDMI
input terminal.

You can display Replace Lamp at any time preset at Environment setup in the
Tool menu.

Detectable error information differs with the projector you are using.

Air filter air flow sensor error

Checking properties in detail

You can check the properties of Group and projectors in detail.
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Displaying Group properties

iInformation; Timer
Procedure Group name Branch &
Projector name test]
Dizplay name: Laobby
You can use either of the following methods to display the 1P adrass 10120220
properties. Lernp Hous o
. . . . . 0 emperature level I:I
¢ Displaying the properties for all groups in Grouping view ; p_tt =
. . . . . escnphon
Right-click in Grouping view and select Property.
e Displaying the specified group properties [Seral s oo ]
Right—click an icon in Grouping view and then select Property. ersion infarmation F1 5400193057 U54090
F2 B400400 /030
F3 6141w 100
— 6 LI) Eg — @ @ @ &%— Eﬁ E@ @ Error information Mo gignal
Type | Dizplay name | Power | Lamp Hours Source | Temperature level | Emar information
_@_ Showroam = .
@ ConventionHi = e e
(@) Looty © M N [l =
@) Shows the projector's serial number. If hyphens are displayed, confirm the serial
number on the label of the projector.
il | Bl @ Displays the projector firmware version.

If you double-click in a line, the properties for that group or projector will
be displayed.

Displaying and deleting logs

. . . . In your web browser, you can check a transmission log of content such as
Displaying Projector properties what has been controlled by EasyMP Monitor, projector errors. You can
Right-click on a projector icon in Grouping view or Detail list view and delete logs once you have checked them.

select Property.

Als

~- When Log output is set to On at Environment setup in the Tool
'@‘ menu, transmission logs are stored. The default setting is Off.
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Displaying Log

Procedure

Select "Log" - "View" from the View menu.

The web browser will open and the communication logs up until that time
will be displayed.

Deleting Log

Select "Log" - "Delete" from the View menu. When the confirmation
message is displayed, click "OK".

All logs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in a
new log.
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Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more than
one projector in Grouping view or Detail list view and clicking a control
button. The methods of selecting more than one projector at the same time
are as follow.

o If you select a group icon in Grouping view, all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.
e Use drag and drop to select a range of desired icons.

_ OX

(tbtb %Esm@mgﬁ@ﬂg

Branch B Branch C

A

Shawaraom

A ©

Showroom A Showroom B

Corwertion
i Labby

@ 5 o

Hol No2 Nod -

The following table shows the meanings of the control buttons.

& Power On Turns the projector power on.
o) Power Off Turns the projector power off.
— Switch source Switches the video input source to the
Dozl Computer1 Computerl port or Computer port.
Switch source Switches the video input source to the
oa5 Computer 2 Computer2 port.
Switch source Switches the video input source to the BNC port.
(-]

BNC

&)

Switch source S-
Video

Switches the video input source to the S-Video
port.

Switch source

Switches the video input source to the Video

) . .

Video (RCA) port or video2 port.

- Switch source Switches the video input source to the Videol

H Video (BNC) port.

= Switch source Switches the video input source to the DVI-D1

EL DVI-D, HDMI 1 port or HDMI1 port.
If the projector is equipped with ether DVI-D
port or HDMI port, use this button to switch the
input signal.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.

— Switch source Switches the video input source to the DVI-D2

=2 DVI-D, HDMI 2 port or HDMI2 port.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
HDMI as an input source.

Switch source D- | Switches the video input source to the D4 port.
.
Video
= Switch source Switches the input source to EasyMP or

EasyMP

EasyMP.net.




Using the control functions

= Switch source Switches the input source to USB Display.
=

USB Display*

Switch source

A use1*

Switches the video input source to the external
equipment connected via a USB (Type A) port or
USBI.

Switches the video input source to the external
equipment connected via a USB2 port.

Switch source

=g | use2*

Switch source

% LAN*

* If the button does not function, you can switch the input source using the

button.

Switches the video input source to the image
projected by the computer via a network.

~- * Some connected projectors may not be equipped with all of the
@‘ above ports or functions. If you click a button for a port or function
that is not available, nothing will happen.

e You can select objects to be controlled and use the control buttons
to carry out control operations even when the following are being
displayed.

Group properties @ p.28

Projector properties @ p.28

Warning and Error Projector list

(Control operations can only be carried out for projectors with a
warning status.) @ p.25

Procedure

' Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

w The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for the
projector. @ Projector's User's Guide

<~ You can select projectors and right-click on them to select Web
@ control even when the following are being displayed.

Group properties @ p.28

Warning and Error Projector list (Control operations can only be
carried out for projectors with a warning status.) @ p.25

Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration menu
settings for projectors.

Carrying out control using timer settings
This is useful for carrying out certain control operations such as turning a
projector's power on and off at specified times every day or every week.

Timer settings can be carried out either for a single projector only, or all at
once for all projectors in a group.

Procedure

Select "Timer" - "Timer Settings" from the Tool menu.

The following window will be displayed and you can then check the timer
setting status.
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Projectors Date
- [ eranch A 1 04/2009 r
= tion Hall
e SUN | MOW | TUE | WED | THU | FRI | SAT
= [ showroom [ 1 1 2 3 4
=l |3, showroom A 5 E 7 s E 0 1
@ Mot 12 13 14 15 16 17 18
& Moz 19 20 21 22 23 24 25
@ No3 26 27 28 29 30
=l |5, showroom B
@D Mot
@ Nos T imers
+| [§ Branch &
5 Branch © Display name Date Timne (24 hour ) Operation
@ Lobby 4f7[2009 18:43 Computerz
vE. Showroom B 417/2009 1845 Power ON
@ Mo 47/2009 18:59 Power ON
\E, Showroom A 417/2009 18:59 Power ON
< | x
I Enabled Digabled I Add Edit Delete O
I I Clase o |

The details that can be checked and operations that can be carried out at
this time are given below.

@ Projectors
Selects a group or projector to check the status of.

When a group is selected, the timer setting statuses for all projectors in that group
are displayed.

@ Date

Shows the current day in a red box.
Days for which timer settings have been made are shown in bold.

Click < or * | to switch to the calendar for the previous or next month.
@ Timers

Shows a list of the timer settings.
The line colors in the Timers list have the following meanings:

[ ] Currentday'stimersetting

11

@ Delete

Delete

@ Close

Close

@ Edit

Edit

@ Add

When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting

When the current day's timer setting is a disabled setting

Timer setting for a day other than the current day

Lets you delete timer settings that have been selected from the
timer list.

Closes the Timer Settings window.

Lets you change the timer settings that have been selected from the
timer list. If a group has been selected for status checking, the
settings cannot be changed.

Registers new timer settings. @ "Procedures for new timer
settings" p.32

© Enabled/disabled

Enabled

Dizabled

Switches the timer settings that have been selected from the timer
list between enabled and disabled.

Procedures for new timer settings

Procedure

Click "Add" on the Timer Settings window. The following

window is displayed and the new timer settings are applied.
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Schedule mods Date

Date |2009104.f 14 j

Time (24 hour] |19:04 -

DOperation |F‘ower ey j
Ok Cancel

At Operation, you can carry out the operations of turning the power
on and off and switching the input sources, similarly for the control
buttons on the main window. If you set the input source switching,
the projector's power will turn on at the timer start time even if it is
not on at the time. Because of this, it is not necessary to make two
separate timer settings for turning the power on and switching the
input source.

) ' After completing the timer settings, click "OK".

The timer settings that have been made will be registered and they
can be checked in the displayed timer list.

<~ You can enable and disable all of the timer settings that have been

:@‘ registered. Select Timer - Enable or Disable from the Tool menu.




Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is i e et “ i - oi
connected to the network assumes a certain status, or if it experiences a
proble.m or warning. By using this function, the operator can })e not.lfled of TP e P s | S —
a projector’s status or problems even when the operator is in a different
location from the projectors. e e s !
Riecipient mail addiess 1 | Motification event
~¥<- * Up to three addressees (destinations) can be registered and messages . | Sthealon et
’@\ can be sent to all Of them at once. Recipient mail address 3 | notification event
e If a critical problem develops with a projector which causes it to ok Cancel
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem. Make th ) hil ferri he table bel
. o ake the necessary settings while reterring to the table below.
o If Standby Mode is set to Communication On (or Network On) or y g 8
Network Monitoring is set to On in the projector configuration Mail notification Set to On to use the mail notification function.
menus, you can monitor the projector even when it is in standby function
mode (when its power is turned off). @ Projector's User's Guide
( : P . - f)_ f ] T SMTP server IP ad- | Enter the IP address of the SMTP server. Up to a
e On ffome projectors, ';I\lleh mail nof:u ication function can be setb in the dress maximum of 255 bytes can be entered.
configuration menu. en notification messages are set to be sent
conls . . . 5 . . When you change a port number of the SMTP server,
in the projector's configuration menu, both the settings in the . . e
. . : specify this port number. The default value is "25".
configuration menu and settings made on EasyMP Monitor are )
functional You can enter a valid number from 1 to 65535.
e Detectable status with the mail notification function differs with the Sender mail address | Enter the sender's e-mail address. Up to a maximum
projector you are using. of 255 bytes can be entered.
Recipient mail ad- Specify the destination addresses for the notification
dress 1 e-mail. Up to three destinations can be set. Up to a
Procedure Recipient mail ad- maximum of 255 bytes can be entered.
; dress 2
Select "Mail notification function" from the Tool menu. Redipi .
ecipient mail ad-
dress 3

The Set mail notification function window will be displayed.

Click "Notification event" and check the items for mail
notification in the window that appears.




Mail notification function settings

Set notification event

|2

Lamp
W Replace Lamp
W Lamp failure at power on
W Lamp Cover Open
W Lamp Error

Air Filter

[V Clean air Filter Natice
¥ Mo air Filter =

W Lo it Flows

V¥ Replace Air Filer

[V it Flow Sensor Er.

IV it filter air flow sensor enmor

V' Low air How emor
Metwork.

[ Metwark errar [TCP connection erar]

[ Metwark error [ESCAP.net communication errar]

[ Metwark error [monitor password authentication error) 7

Cancel

gwum,%

W
m’

' Click "OK".

The Set mail notification function window appears again.

i
2

—

N

Repeat Steps 3 and 4 to set the notification events to be notified.

When the setup is complete, click "OK".




An e-mail notifying the operator of a problem/warning/status is issued

If the projector experiences a problem or enters a status requiring attention,
an e-mail like that shown below is sent to the address specified for
Recipient mail address.

If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.

Item Details shown

E-mail subject [Display name displayed in Grouping view or Detail list

view] Projector status notification

Body <Display name displayed in Grouping view or Detail list
view> has entered the following status.
<Warning/error/status message (Please see the table
below)>

The details contained in the e-mail message can consist of the following.

Message Remedy

Refer to Reading the indicators.
@ Projector's User's Guide

Internal Error

Fan error

Sensor error

Lamp Cover Open

Lamp failure at power

*

on

Lamp Error*

Supply System Error
(Ballast)*

High internal tempera-
ture error

Low air flow error

Air filter air flow sen-
SOr error

Cinema filter error

Message

Remedy

Shutter error

Cooling system error
(Peltier element)

Cooling system error
(pump)

High-temperature
warning

Replace Lamp”

Lamp error”

Lamp failure at power

*

on

Supply System Error
(Ballast)*

Replace Air Filter

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Cinema filter warning

Shutter warning

Clean Air Filter Notice

No signal

No image signals are being received by the projector.
Check the connection status and check that the power
for the connected equipment is turned on.

Other error

Auto Iris Error

Stop using the projector, disconnect the power cable
from the electrical outlet, and contact your local dealer
or the nearest address provided in the Support and

Service Guide supplied with the projector.




An e-mail notifying the operator of a problem/warning/status is issued

Message Remedy

Network error (TCP Check the following items.

connection error) Check that the projector's power is turned on.
Check that the LAN cable is connected.

Check that Standby Mode is set to Communication On
(or Network On) or Network Monitoring is set to On
in the projector's configuration menu.

@ Projector's User's Guide

Network error Check that the projector has been correctly connected
(ESC/VP.net communi- | to the network. @ Projector's User's Guide
cation error)

Network error (Moni- | Check the projector's Monitor Password.
tor Password authenti-
cation error)

¥  When the projector has 2 lamps, the additional information, such as (Lamp 1)

or (Ballast 1), is displayed after the message so that you can know witch lamp
has problems/warnings.

Messages to inform that the projector has recovered from the error or
warning statuses are sent.



Application lock function

You can use the application lock to prevent third parties from operating the
projectors using EasyMP Monitor and from changing settings without
authority. Opening and closing EasyMP Monitor and status monitoring can
still be carried out even when the application lock is applied.

In addition, when a password has been set, the password must be entered
in order to cancel the application lock. This ensures that the application
lock can not be easily cancelled, and thus improves system security.

/ The password entry window will be displayed, so enter the set

password and then click "OK".

If no password has been set (default setting), click OK without
entering a password. It is recommended that you enter a password in
order to strengthen security.

The application lock will be cancelled and operations can be carried
out as normal.

Switching Application lock between enabled and
disabled

Enabling the application lock

Procedure

Select "Application lock" from the Tool menu.

The application lock will be enabled and no operations will be possible
other than opening and closing EasyMP Monitor and disabling the
application lock.

Disabling the application lock

Procedure

Select "Application unlock" from the Tool menu.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

Procedure

/ Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

| Select "Change the application lock password".

. | Enter the password in both the "New password" and "New
password (confirm)" boxes and then click "OK".

The password can be up to 16 bytes in length. Single-byte
alphanumeric characters can be used.
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Troubleshooting

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Have the SMTP server IP
address, Port Number and
Recipient mail address all been
set correctly?

Check the setting details.

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install it.
@ p3

Are all the projectors that you
want to control or monitor
registered?

Register the projectors. @ p.11

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily stop
working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has been
checked, contact your dealer or the nearest address
provided in the Support and Service Guide supplied
with the projector.

An e-mail message is not sent when a problem
occurs with a projector

Is power being supplied to the
projector?

Check if the power supply to the location where the
projector is set up has been interrupted, or if the
circuit breaker for the electrical outlet that the
projector is connected to has been tripped.

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.




Uninstalling EasyMP Monitor

The following procedures to uninstall EasyMP Monitor vary depending on
your oprating system.

e If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP
Click Start - (Settings) - Control Panel - Add/Remove Programs or Add
or Remove Programs to uninstall EasyMP Monitor. To save or transfer
the existing projector settings, make a copy of the EMP Monitor.dat file
before you uninstall the software. @ "Transferring the settings" p.7

e When your operating system is Windows Vista or Windows 7
Click Start - Control Panel - Uninstall a program to uninstall EasyMP
Monitor. The settings and logs remain on the hard disk after EasyMP
Monitor is uninstalled. If you do not need this information, delete the
EasyMP Monitor Ver. x.xx (Ver. x.xx represents the version of the
existing software) folder. This folder can be found at "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector" if
the default settings were used to install the software. To save or transfer
the projector settings, make a copy of the EMP Monitor.dat file before
you delete the folder. @ "Transferring the settings" p.7



General Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval ©SEIKO EPSON CORPORATION 2009. All rights reserved.
system, or transmitted in any form or by any means, electronic, mechanical,

photocopying, recording, or otherwise, without the prior written permission of Seiko

Epson Corporation. No patent liability is assumed with respect to the use of the

information contained herein. Neither is any liability assumed for damages resulting

from the use of the information contained herein.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this
product or third parties for damages, losses, costs, or expenses incurred by the
purchaser or third parties as a result of: accident, misuse, or abuse of this product or
unauthorized modifications, repairs, or alterations to this product, or (excluding the
U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems arising
from the use of any options or any consumable products other than those designated as
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

The contents of this guide may be changed or updated without further notice.

Mlustrations in this guide and the actual projector may differ.

Trademarks

Microsoft, Windows, Windows NT, Windows Vista, Windows 7, and
Windows logo are trademarks of Microsoft Corporation in the United
States of America and other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

EasyMP and EasyMP.net are trademarks of Seiko Epson Corporation.
Other product names used herein are also for identification purposes only
and may be trademarks of their respective owners. Epson disclaims any and
all rights in those marks.
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